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Impulse Response Utility est une application de déconvolution et d’enregistrement audio
multipiste. Il vous permet de créer vos propres fichiers de réponse d’impulsion pour
Space Designer, un effet de réverbération à convolution.Bien que Space Designer soit
livré avec de nombreux effets sonores de halls, de délais et autres réverbérations, vous
souhaitez peut-être créer une réponse d’impulsion de votre propre studio, cuisine, salle
de bain voire théière.

Cette préface traite des sujets suivants :

• À propos d’Impulse Response Utility (p 5)

• À propos de la documentation d’Impulse Response Utility (p 5)

• Ressources supplémentaires (p 6)

À propos d’Impulse Response Utility
Impulse Response Utility est conçu pour fonctionner en toute transparence avec Space
Designer. Vous pouvez enregistrer et modifier des réponses d’impulsion et créer des
fichiers Space Designer rapidement et facilement. Tous les outils nécessaires pour maîtriser
le processus complexe de création d’une réponse d’impulsion, tels qu’un générateur de
balayage flexible, des modules d’édition puissants et une création en un clic de réglages
Space Designer, sont inclus. Tout ce dont vous avez besoin, c’est de votre Mac, d’Impulse
Response Utility et, bien sûr, d’une interface audio connectée aux haut-parleurs et aux
microphones.

À propos de la documentation d’Impulse Response Utility
Le Manuel de l’utilisateur d’Impulse Response Utility (ce document) décrit uniquement
l’application Impulse Response Utility. Pour plus d’informations sur Space Designer,
consultez le manuel Effets Logic Studio.

• Manuel de l’utilisateur d’Impulse Response Utility : ce manuel fournit des instructions
exhaustives sur l’utilisation d’Impulse Response Utility pour créer vos propres réponses
d’impulsion mono, stéreo et Surround pour Space Designer, l’effet de réverbération à
convolution.
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• Effets de Logic Studio : ce manuel fournit des instructions pour l’utilisation d’une
collection puissante d’effets inclus avec Logic Pro.

Ressources supplémentaires
Outre la documentation fournie avec Logic Pro, une grande variété de ressources existe
que vous pouvez utiliser pour en savoir plus.

Site web de Logic Studio
Pour des informations générales et des mises à jour, ainsi que les dernières informations
disponibles sur Logic Pro, accédez à l’adresse :

• http://www.apple.com/fr/logicpro

Sites web de service et assistance Apple
Pour des mises à jour logicielles et des réponses aux questions les plus fréquemment
posées sur tous les produits Apple, consultez la page web générale d’assistance Apple.
Vous accéderez ainsi également aux spécifications des produits, à la documentation de
référence et à des articles techniques sur les produits Apple et de tierce partie.

• http://www.apple.com/fr/support

Pour des mises à jour logicielles, de la documentation des forums de discussion et des
réponses aux questions les plus fréquemment posées sur Impulse Response Utility,
rendez-vous à l’adresse :

• http://www.apple.com/fr/support/logicpro

Pour des forums de discussion pour tous les produits Apple du monde entier, des réponses
à vos questions, consultez le site (en anglais) :

• http://discussions.apple.com
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Space Designer combine ou convolue la réponse d’impulsion d’un espace acoustique
avec un signal audio. Cela a pour effet de placer votre audio « dans » l’espace acoustique,
représenté par cette réponse d’impulsion. Une réponse d’impulsion peut être vue comme
la somme des échos (réflexions) produits dans un espace physique donné après le pic
initial d’un signal. Le fichier de réponse d’impulsion est en fait un enregistrement audio
réalisé dans un espace contenant ces échos.

Deux méthodes pratiques peuvent être utilisées pour enregistrer une réponse d’impulsion.
Celle des éléments transitoires et le balayage sinusoïdaal.

Le présent chapitre couvre les aspects suivants :

• Enregistrement de réponse d’impulsion : méthode Transients (p 7)

• Enregistrement de réponse d’impulsion : méthode Sine Sweep (p 8)

Enregistrement de réponse d’impulsion : méthode Transients
Cette méthode consiste à enregistrer une impulsion dans un espace à l’aide, par exemple,
d’un pistolet de starter. Le coup de feu constitue l’impulsion, et le fichier audio que vous
enregistrez capture à la fois cette impulsion et la réponse de la pièce.

L’avantage de cette méthode est que le fichier audio enregistré peut être utilisé dans
Space Designer sans être traité auparavant. Vous pouvez utiliser Impulse Response Utility
pour enregistrer les impulsions de votre pistolet de starter, puis les combiner dans un
fichier de réponse d’impulsion Space Designer (.sdir) (et un fichier de réglage Space
Designer).

L’inconvénient de cette méthode est qu’il est extrêmement difficile de réaliser un
enregistrement parfait de coup de feu sans distorsion. Cela s’explique par la très forte
intensité sonore de l’élément transitoire initial du coup de feu. L’autre problème est que
les coups de feu d’un pistolet de starter contiennent très peu d’informations de basse ou
haute fréquence, ce qui limite la plage de fréquences utilisable de la réverbération
convoluée.
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Enregistrement de réponse d’impulsion : méthode Sine Sweep
Il s’agit de la méthode préférée pour créer des réponses d’impulsion. Cela implique la
lecture d’un balayage sinusoïdal audio haut débit dans un espace et l’enregistrement du
balayage (et de l’espace) à des niveaux d’enregistrement optimaux. Un balayage sinusoïdal
couvrant la totalité de la plage de fréquences audible est utilisé, ce qui permet d’obtenir
une réponse d’impulsion bien souvent de meilleure qualité avec une plage de fréquences
étendue.

Le fichier audio du balayage sinusoïdal enregistré ne peut pas être utilisé directement
comme réponse d’impulsion. Il contient en effet tous les échos et toutes les réflexions,
c’est-à-dire la réponse, de l’espace, et ce sur toute la longueur du balayage sinusoïdal, ce
qui est très différent de l’approche avec le pistolet de starter, où la réponse est contenue
au début du fichier dans une impulsion.

Lorsque vous utilisez un balayage sinusoïdal, Impulse Response Utility utilise un processus
appelé déconvolution pour réaliser un alignement temporel et de niveau de toutes les
réflexions enregistrées, qui sont présentes sur la totalité du balayage sinusoïdal enregistré,
au tout début du fichier. Cela produit une réponse d’impulsion que Space Designer peut
utiliser pour combiner, ou convoluer, avec votre signal audio. Impulse Response Utility
peut ensuite générer un fichier de réglage .sdir à partir de cette réponse d’impulsion.
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Avant de pouvoir utiliser Impulse Response Utility pour créer une réponse d’impulsion,
vous devez configurer votre matériel d’enregistrement pour qu’il puisse lire et enregistrer
le balayage sinusoïdal généré par Impulse Response Utility.

La réponse d’impulsion d’un espace n’est jamais uniquement la réponse d’impulsion de
cet espace. La réponse d’impulsion enregistrée est toujours la réponse de l’ensemble du
système, c’est-à-dire de chaque élément de l’équipement que vous utilisez pour réaliser
vos enregistrements. Cela inclut, dans l’ordre du trajet du signal : le convertisseur
numérique-analogique, l’amplificateur et les haut-parleurs (ou les haut-parleurs amplifiés),
les caractéristiques de la pièce, les micros et, enfin, le préamplificateur du micro et le
convertisseur analogique-numérique. Par conséquent, avant de quitter votre studio pour
aller enregistrer la réponse d’impulsion d’un espace, vous devez penser à l’équipement
que vous allez emporter. De nos jours, même les convertisseurs bon marché offrent une
qualité acceptable, votre attention devra donc se porter sur la sélection des haut-parleurs
et des micros.

Le présent chapitre couvre les aspects suivants :

• Configuration idéale d’enregistrement d’une réponse d’impulsion (p 10)

• Configuration alternative d’enregistrement d’une réponse d’impulsion (p 11)

• Recommandations pour la sélection des micros et des haut-parleurs (p 12)

• Recommandations pour le positionnement des haut-parleurs et des micros (p 13)
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Configuration idéale d’enregistrement d’une réponse
d’impulsion
Lorsque vous procédez à l’enregistrement d’une réponse d’impulsion, vous devez
idéalement disposer des éléments suivant :

• Un haut-parleur pour chaque emplacement (de haut-parleur) requis par le format choisi,
si vous prévoyez de générer des balayages d’onde sinusoïdale. Exemples : si vous
enregistrez une vraie réponse d’impulsion stéréo, il vous faut deux haut-parleurs. Si
vous enregistrez une réponse d’impulsion Surround à six canaux, il vous en faut six, etc.
Si vous ne générerez pas de balayages d’onde sinusoïdale, vous n’avez pas besoin de
haut-parleurs pour les lire (le son est généré par le pistolet de starter).

Remarque : dans la plupart des cas, vous pouvez vous contenter d’enregistrer une
seule position de haut-parleur (mais toutes les positions de micro requises par le format
de réponse d’impulsion choisi) et de créer une réponse d’impulsion discrète mono/omni.
Cela permet d’obtenir une réponse d’impulsion nécessitant moins de puissance de
l’unité centrale dans le format requis. Voir Enregistrement d’une réponse d’impulsion
à 5 canaux Mono vers Omni.

• Un ou plusieurs micros pour enregistrer l’audio résultant produit par chaque haut-parleur
(ou par votre pistolet de starter) combiné avec ses échos/réflexions. Le nombre de
micros dont vous avez besoin dépend du format de réponse d’impulsion choisi.
Exemples : si vous enregistrez une réponse d’impulsion Surround à six canaux, il y a six
positions de micro, vous devez donc dans l’idéal disposer de six micros. Si vous
enregistrez une réponse d’impulsion encodée au format B à six canaux, pour laquelle
une seule position de micro et quatre pistes sont nécessaires, il vous en faut moins, etc.
Voir Encodage Surround au format B pour en savoir plus.

• Une interface audio dotée de suffisamment de sorties pour envoyer un balayage
sinusoïdal audio à large bande à chaque haut-parleur (en cas d’utilisation de balayages
sinusoïdaux) et de suffisamment d’entrées pour enregistrer l’audio résultant de chaque
position.
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Remarque : vous pouvez également avoir besoin de préamplificateurs de micro
supplémentaires si vos micros ne sont pas en mesure de capturer un signal suffisamment
fort ou si votre interface audio ne dispose pas d’assez d’entrées avec préamplificateur de
micro.

Exemple de haut-parleurs et de micros configurés pour la capture d’une réponse d’impulsion multicanal 5.1

Ordinateur

Interface audio
Surround

micro
système

C
DG

RsLs

Configuration alternative d’enregistrement d’une réponse
d’impulsion
Il est possible de créer des réponses d’impulsion multipiste discrètes, même si vous n’avez
pas suffisamment de haut-parleurs ou de micros. Dans la mesure où vous n’enregistrerez
qu’un seul balayage sinusoïdal à la fois, vous pouvez installer les haut-parleurs dont vous
disposez, les enregistrer dans Impulse Response Utility, puis les placer sur de nouvelles
positions et répéter la procédure. Imaginez par exemple que vous n’ayez qu’une seule
paire de haut-parleurs stéréo, mais que vous souhaitiez créer une réponse d’impulsion
quadriphonique, ce qui nécessite l’enregistrement de quatre pistes dans quatre positions
de haut-parleur différentes. Vous pourriez dans ce cas installer votre paire de moniteurs,
enregistrer leur sortie, puis les déplacer pour enregistrer l’autre paire de pistes dans les
deux autres positions de haut-parleur.

Cette méthode de création de réponses d’impulsion prend évidemment plus de temps,
et le fait de ne pas pouvoir installer tous vos haut-parleurs en même temps complique
l’optimisation de leur positionnement l’un par rapport à l’autre. Avec du temps et une
planification minutieuse, vous pouvez toutefois obtenir les mêmes résultats.
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vous pouvez également créer des réponses d’impulsion à plusieurs canaux dans Impulse
Response Utility en utilisant le format « Mono to Omni Discrete ». Ce format ne nécessite
l’enregistrement que d’un seul haut-parleur par autant de micros « canal » que nécessaire
(pour le format choisi). La réponse d’impulsion obtenue nécessite moins de puissance
de l’unité centrale. Voir Enregistrement d’une réponse d’impulsion à 5 canaux Mono vers
Omni.

Si vous avez suffisamment de moniteurs mais pas assez de micros, vous pouvez installer
les haut-parleurs requis et déplacer les micros disponibles de l’un à l’autre. Cette méthode
complique l’optimisation du positionnement des micros l’un par rapport à l’autre, mais
vous conservez tout de même l’avantage du positionnement idéal des haut-parleurs (il
est beaucoup plus facile de déplacer des micros que des haut-parleurs !).

Si votre interface audio n’offre pas suffisamment d’entrées et de sorties pour le nombre
de haut-parleurs et de micros que vous utilisez pour créer votre réponse d’impulsion,
vous pouvez tout de même installer tous les micros et haut-parleurs. Lors de
l’enregistrement des différentes pistes dans Impulse Response Utility, vous devrez
déconnecter/reconnecter les haut-parleurs et les micros à tour de rôle.

Vous trouverez une présentation plus détaillée des haut-parleurs et des micros convenant
à la création des réponses d’impulsion, ainsi que des suggestions concernant leur
positionnement, dans les rubriques Recommandations pour la sélection des micros et
des haut-parleurs et Recommandations pour le positionnement des haut-parleurs et des
micros.

Recommandations pour la sélection des micros et des
haut-parleurs
Il n’existe aucune règle quant à la marque de micro ou de haut-parleur qui permettra
d’obtenir la meilleure réponse d’impulsion. Un bon point de départ consiste à utiliser des
haut-parleurs et des micros ayant une réponse linéaire (ce qui signifie qu’ils produisent
un signal égal à toutes les fréquences). Vous trouverez des micros et des haut-parleurs
offrant des réponses relativement linéaires à pratiquement tous les prix. Les micros à
lampe, généralement appréciés pour la « couleur » qu’ils ajoutent au signal, ne constituent
pas nécessairement la meilleure option pour l’enregistrement de réponses d’impulsion.
Les micros utilisés comme micros d’ambiance sont généralement de bons candidats.
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Recommandations pour le positionnement des haut-parleurs
et des micros
L’endroit où vous placez vos haut-parleurs et vos micros dans l’espace d’enregistrement
a un impact important sur les échos et les réflexions particuliers capturés par votre réponse
d’impulsion. Il va sans dire que la créativité est la clé du succès et que tout repose sur
l’expérimentation.

Il existe toutefois quelques recommandations et principes généraux qui pourront vous
aider à réaliser vos premiers enregistrements.

Recommandation générale pour le positionnement dans les environnements présentant
des sols durs faits de matériaux tels que le béton : il se peut qu’un son strident soit
enregistré au début de votre réponse d’impulsion. Ce son est en réalité le balayage
sinusoïdal généré résonnant à travers le plancher dans le support du micro, puis dans le
micro en lui-même. Le son se propage en effet beaucoup plus vite dans les sols et le
béton que dans l’air, ce qui produit une réponse pré-impulsionnelle avant celle que vous
souhaitez enregistrer. Pour éviter ce problème potentiel, vous pouvez utiliser des pieds
de batterie de « studio » et des suspensions de micro spéciaux dotées de puissants
absorbeurs acoustiques intégrés. Si vous ne pouvez pas emmener de pieds de batterie
ou si vous n’avez pas les moyens d’acheter des supports de micro onéreux, essayez de
placer un tapis épais sous les haut-parleurs et le ou les pieds de micro.

Vous trouverez ci-dessous certaines approches spécifiques que vous pouvez essayer lors
de la création de réponses d’impulsion. Gardez à l’esprit qu’il ne s’agit que de suggestions.
Il n’existe aucune règle quant à la distance à laquelle les haut-parleurs doivent être éloignés
de la batterie de micros, aux angles optimaux, à la distance idéale entre les haut-parleurs
et les micros, etc. Vous pouvez essayer différentes techniques et différents positionnements
pour trouver la configuration idéale. La création de réponses d’impulsion est un art !

Approche de l’auditeur virtuel
Il s’agit sans doute de la technique la plus courante pour positionner les haut-parleurs et
les micros en vue de créer des réponses d’impulsion. L’objectif est de capturer l’effet des
échos et des réflexions produits par tout l’espace, tels qu’ils sont entendus à la position
d’écoute. Dans cette approche, les haut-parleurs sont installés sur les côtés de la pièce
et le micro est placé à la position d’écoute.
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La réponse d’impulsion résultante (lorsque vous l’utilisez plus tard dans Space Designer
pour ajouter de la réverbération à votre signal) doit donner l’impression que votre audio
provient des différentes positions de haut-parleur dans l’« espace ». Il n’est pas nécessaire
d’avoir plusieurs micros pour cette méthode ; un seul micro peut être dirigé tour à tour
vers chacun des haut-parleurs et plusieurs enregistrements audio peuvent être réalisés
depuis le même emplacement. L’image ci-dessous illustre l’approche de l’auditeur virtuel
pour positionner cinq haut-parleurs (pour une réponse d’impulsion Surround à cinq
canaux), avec un micro placé au centre de l’espace.

C
DG

DsGs Surround
micro

système

Cette méthode permet de donner l’impression que le signal audio est complètement
immergé dans l’espace simulé.
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Approche de l’auralisation
L’auralisation est une autre méthode courante pour le positionnement des haut-parleurs
et des micros dans un espace. Cette technique consiste à essayer de capturer les réflexions
depuis la position de l’interprète. Installez un ou plusieurs haut-parleurs à la position de
l’interprète (ou d’une autre source audio) et placez un micro à la position d’écoute. La
réponse d’impulsion résultante donne l’impression que votre audio est lu à nouveau
depuis l’emplacement même de ces haut-parleurs. Vous pouvez utiliser la technique de
l’auralisation pour créer, par exemple, une réponse d’impulsion stéréo d’une scène
particulière. Lorsque vous utilisez cette réponse d’impulsion dans Space Designer, votre
audio doit donner l’impression qu’il provient de cette scène. L’image ci-dessous illustre
l’utilisation de la technique de l’auralisation pour positionner vos haut-parleurs et vos
micros en vue de créer une réponse d’impulsion stéréo véritable.

Scène

Public

G D

Pour capturer une réponse d’impulsion Surround donnant l’impression d’être « dans le
public » d’un espace, installez deux haut-parleurs à la position de l’interprète comme
illustré ci-dessus, mais placez un ensemble Surround de micros autour de la pièce. Cela
permet de créer l’impression (et l’effet) réaliste d’être « dans le public », comme si
l’interprétation avait lieu face à vous. Vous pouvez ainsi créer un effet Surround à partir
d’un enregistrement stéréo en direct.
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Approche de la chambre d’échos virtuelle
Une bonne alternative à l’approche de l’auralisation consiste à placer vos haut-parleurs
et vos micros de façon à créer un espace virtuel ressemblant à une chambre d’échos
réelle. Pour créer ce genre de réponse d’impulsion, orientez les haut-parleurs vers deux
coins de la pièce et les micros vers les coins opposés. C’est ainsi que seraient positionnés
les micros dans une chambre d’échos réelle. Cela élimine tout chemin direct entre le
haut-parleur et le micro et permet de capturer davantage de réflexions. L’image ci-dessous
illustre la façon dont vous pouvez positionner deux haut-parleurs et deux micros pour
créer une réponse d’impulsion stéréo à l’aide de cette approche de chambre d’échos
virtuelle.

G D

La réponse d’impulsion qui résulte vous permet de mixer la réverbération avec le signal
sec sans problèmes d’annulation de phase causés par les premières réflexions ou les
signaux directs. Cette approche fonctionne particulièrement bien si vous souhaitez
conserver un signal pratiquement sec, non altéré ni coloré par la réverbération, tout en
ajoutant une pointe de réverbération haute fidélité à votre audio.
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Vous pouvez également utiliser cette méthode pour créer des réverbérations Surround
ou à plusieurs canaux. Le principal concept à garder à l’esprit est que les haut-parleurs
doivent être orientés vers le mur afin d’éliminer tout chemin direct entre ces derniers et
les micros. L’illustration ci-dessous présente une disposition possible pour une chambre
de réverbération à cinq canaux. Les haut-parleurs, positionnés en cercle, sont dirigés vers
les murs, et l’ensemble de micros est placé au centre du cercle.

Surround
micro

système

C
DG

DsGs
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Ce chapitre aborde la création de vos propres réponses d’impulsion pour une utilisation
dans Space Designer.

Le présent chapitre couvre les aspects suivants :

• Présentation de l’interface (p 20)

• Présentation du processus (p 20)

• Création de votre projet (p 21)

• Assignation du matériel d’entrée et de sortie (p 22)

• Configuration des paramètres du moniteur (p 23)

• Configuration du générateur de balayage (p 24)

• Enregistrement audio dans Impulse Response Utility (p 25)

• Déconvolution de votre réponse d’impulsion (p 28)

• Édition de votre réponse d’impulsion (p 29)

• Écoute de votre réponse d’impulsion (p 30)

• Création d’un réglage Space Designer (p 32)

• Enregistrement, ouverture et retour aux projets enregistrés (p 33)
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Création de réponses d’impulsion
dans Impulse Response Utility 3



Présentation de l’interface
Tous les paramètres et toutes les fonctions dont vous avez besoin pour créer des réponses
d’impulsion sont réunis dans un même écran.

Section du moniteur et du 
générateur de balayage

E/S matériel
Zone d’attribution Zone de montage

Entrées/section de piste

L’interface d’Impulse Response Utility est divisée en quatre zones :

• Zone Hardware I/O Assignment : comprend des menus locaux permettant de sélectionner
l’appareil d’entrée et de sortie audio.

• Section « Monitor and Sweep Generator » : contient des paramètres de monitoring et de
génération de balayage sinusoïdal, ainsi que des boutons permettant de déconvoluer
vos pistes audio en une réponse d’impulsion et d’écouter cette dernière.

• Section Inputs/Track : répertorie toutes les pistes audio utilisées pour vos enregistrements
de réponse d’impulsion.

• Zone Editing : affiche les informations audio de la piste audio sélectionnée.

Présentation du processus
Les étapes nécessaires à la création d’une réponse d’impulsion dans Impulse Response
Utility sont les suivantes :

Étape 1 : Création d’un projet de réponse d’impulsion
Configurez votre projet Impulse Response Utility pour le nombre de pistes nécessaire au
format de réponse d’impulsion choisi.
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Étape 2 : Définition des paramètres d’Impulse Response Utility
Définissez les paramètres d’entrée et de sortie matérielles, du moniteur et du balayage
pour l’enregistrement de vos pistes audio.

Étape 3 : Enregistrement
Utilisez Impulse Response Utility pour enregistrer les pistes audio nécessaires à votre
réponse d’impulsion.

Étape 4 : Déconvolution de vos enregistrements audio
Si vous avez enregistré des balayages sinusoïdaux, cliquez sur Deconvolve une fois toutes
les pistes audio enregistrées. Impulse Response Utility génère alors une réponse
d’impulsion à partir de vos pistes.

Étape 5 : Édition et écoute
Coupez les parties de silence, appliquez des fondus, etc., pour optimiser votre réponse
d’impulsion.

Étape 6 : Création d’un réglage Space Designer
Cliquez sur Create Space Designer une fois toutes les étapes ci-dessus terminées. Cela
ajoute la réponse d’impulsion créée à votre liste de réglages Space Designer disponibles.

Création de votre projet
Lorsque vous ouvrez Impulse Response Utility pour la première fois, la fenêtre « New
Impulse Response Project » s’affiche. Il s’agit de la première étape de la création d’un
projet de réponse d’impulsion. Vous pouvez également créer un projet en choisissant
File > New Project (ou en appuyant sur Commande + N).

Impulse Response Utility propose divers formats allant des formats conventionnels stéréo,
véritable stéréo (où chaque canal est traité individuellement) et quadriphoniques, aux
formats Surround à cinq, six ou sept canaux. Ces autres formats peuvent être présents
dans un multipiste traditionnel ou en encodage de format B. Voir Encodage Surround au
format B pour en savoir plus.
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Vous pouvez également créer des réponses d’impulsion à plusieurs canaux dans Impulse
Response Utility en utilisant le format « Mono to Omni Discrete ». Ce format ne nécessite
l’enregistrement que d’un seul haut-parleur par autant de micros « canal » que nécessaire
(pour le format choisi). La réponse d’impulsion obtenue nécessite moins de puissance
de l’unité centrale. Voir Enregistrement d’une réponse d’impulsion à 5 canaux Mono vers
Omni.

Pour créer un projet de réponse d’impulsion
1 Choisissez un format de réponse d’impulsion dans le menu local Configuration.

Dans la fenêtre située sous le menu local Configuration, la zone de dialogue affiche le
nombre de positions de haut-parleur et de micro requis par le format sélectionné.

2 Cliquez sur OK.

La zone de dialogue « New Impulse Response Project » se ferme et le nombre de pistes
requis (déterminé par le format choisi) s’affiche dans la section Inputs/Track.

Assignation du matériel d’entrée et de sortie
Vous devez configurer le périphérique d’entrée et de sortie audio dans la zone « Hardware
I/O Assignment » avant de pouvoir utiliser Impulse Response Utility

La sélection de l’entrée audio détermine le périphérique audio utilisé pour enregistrer
les pistes audio. La sélection de la sortie audio détermine le périphérique audio utilisé
pour contrôler le signal enregistré et lire le balayage sinusoïdal généré.

Pour sélectionner un périphérique d’entrée audio
µ Dans le menu local Audio Input, choisissez un pilote d’interface audio.

Pour sélectionner un périphérique de sortie audio
µ Dans le menu local Audio Output, choisissez un pilote d’interface audio.

Remarque : même si la zone « Hardware I/O Assignments » affiche également la fréquence
d’échantillonnage actuelle, vous ne pouvez pas modifier la fréquence d’échantillonnage
de votre projet de réponse d’impulsion dans Impulse Response Utility. Si vous souhaitez
enregistrer vos pistes audio à une autre fréquence d’échantillonnage, vous devez la
modifier dans l’utilitaire Audio MIDI Setup ou dans le logiciel de votre interface audio (le
cas échéant). En cas de doutes, reportez-vous à la documentation de votre interface audio.
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Configuration des paramètres du moniteur
Après avoir enregistré des pistes de balayage sinusoïdal dans Impulse Response Utility,
vous pouvez les contrôler via la sortie stéréo de votre choix. Les commandes du moniteur
déterminent le canal et le niveau de ce dernier. Vous pouvez également désactiver le son
de la section du moniteur.

Pour sélectionner les canaux de sortie du moniteur stéréo
µ Choisissez la paire de sorties stéréo souhaitée dans le menu Monitor Channel.

Pour ajuster le niveau de sortie du signal contrôlé
1 Cliquez dans le champ Monitor Level.

2 Effectuez l’une des opérations suivantes :

• Faites glisser le pointeur vers la gauche (ou le bas) pour réduire le volume ou vers la
droite (ou le haut) pour l’augmenter.

• Saisissez une valeur numérique pour le niveau du moniteur (toute valeur supérieure à
0 dB règle le niveau du moniteur sur 0 dB).

Important : pour éviter l’effet de Larsen pendant l’enregistrement, veillez à désactiver le
son de la sortie du moniteur.

Pour désactiver le son de la sortie du moniteur
µ Sélectionner la case Monitor Mute ou appuyer sur la touche M.
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Configuration du générateur de balayage
Le générateur de balayage produit une onde sinusoïdale balayant progressivement la
plage de fréquences de 20 Hz jusqu’à 20 kHz. Les paramètres du générateur de balayage
définissent la sortie matérielle, le volume, la longueur, le temps de réverbération et le
pre-roll du balayage sinusoïdal.

• Menu local Sweep Channel : choisissez le canal d’entrée que vous voulez utiliser.

• Menu local Test Tone : choisissez une fréquence de tonalité de test pour le générateur
de tonalité d’onde sinusoïdale avec soutien (autrement dit, sans balayage). Cette
commande vous permet d’étalonner vos sorties matérielles. Utilisez ce signal de test
pour vérifier que le canal de sortie matérielle est correctement connecté et que vos
haut-parleurs peuvent reproduire la fréquence d’onde sinusoïdale sélectionnée.

• Case On : cochez cette case pour entendre la tonalité de test.

• Champ Sweep Level : définit le niveau de la tonalité de test.

• Menu local Sweep Length : définit la durée de balayage. Dans l’idéal, l’onde sinusoïdale
doit être courte. Ceci évite que des objets apparaissent dans votre enregistrement en
raison des mouvements d’air, des bruits intérieurs ou d’autres bruits ambiants.
Malheureusement, les balayages courts peuvent ne pas produire un rapport signal/bruit
suffisamment élevé dans certaines situations d’enregistrement. Si vous estimez que les
résultats obtenus à partir d’un enregistrement de 10 secondes ne sont pas satisfaisants,
essayez avec une durée de 50 secondes.

Trois options de longueur sont disponibles pour le balayage sinusoïdal :

• 10 s : un balayage sinusoïdal de dix secondes.

• 50 s : un balayage sinusoïdal de cinquante secondes.

• Off : aucun balayage sinusoïdal. Choisissez ce réglage si vous enregistrez une
impulsion de pistolet de starter.

24 Chapitre 3 Création de réponses d’impulsion dans Impulse Response Utility



• Champ Reverb Time : détermine le temps d’enregistrement maximal pour chaque piste.
Pour capturer avec précision les propriétés acoustiques d’un espace, vous devez définir
un temps suffisamment long pour capturer la phase de rétablissement de toutes les
réverbérations et de tous les échos.

Si vous utilisez le générateur de balayage, le temps de réverbération commence lorsque
le balayage sinusoïdal se termine. Si vous avez réglé le paramètre Sweep Length sur
Off (en vue d’enregistrer la réponse d’impulsion d’un coup de pistolet de starter), le
paramètre Reverb Time détermine la longueur totale de l’enregistrement.

• Case Preroll : le but est de s’assurer qu’aucun bruit d’opérateur, tels que les bruits de
frappe ou encore ceux dus au réajustement des micros, n’est enregistré. Pour ce faire,
vous pouvez définir un pre-roll. L’enregistrement ne débutera pas immédiatement, ce
qui vous laissera le temps de terminer la frappe, de corriger la position des micros au
dernier moment si nécessaire, etc. La durée du pre-roll est identique à celle définie
pour le paramètre Reverb Length.

Enregistrement audio dans Impulse Response Utility
Après avoir effectué vos assignations matérielles et configuré le moniteur ainsi que les
paramètres de balayage sinusoïdal, vous pouvez commencer à enregistrer vos pistes
audio.

Si vous utilisez le générateur de balayage, vous entendrez le balayage d’onde sinusoïdale
sur toute sa plage de fréquences. Impulse Response Utility enregistre le résultat sur la ou
les pistes audio sélectionnées.

Si vous avez défini le générateur de balayage sur Off, cliquez sur Record et donnez un
coup de pistolet de starter. Impulse Response Utility enregistre la réponse d’impulsion
résultante sur la piste audio sélectionnée.

Pour sélectionner une piste audio
Procédez de l’une des manières suivantes :

µ Cliquez dans une bande de piste.

µ Utilisez les touches Flèche vers le haut et Flèche vers le bas pour parcourir la liste des
pistes.

Pour enregistrer dans Impulse Response Utility
1 Sélectionnez une piste audio dans la section Inputs/Track.

2 Configurez la piste audio pour l’enregistrement.

3 Répétez cette étape pour chaque piste requise par le format choisi.

4 Cliquez sur le bouton Sweep/Record pour lancer l’enregistrement.
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Configuration des pistes audio pour l’enregistrement
La section Inputs/Track affiche automatiquement le nombre de pistes requis pour
l’enregistrement de la réponse d’impulsion en fonction de vos sélections dans la zone
de dialogue « New Impulse Response Project ». Chaque bande de piste de la section
Inputs/Track présente un certain nombre de paramètres. Certains d’entre eux sont
automatiquement configurés par Impulse Response Utility, les autres doivent être définis
par l’utilisateur avant l’enregistrement.

Paramètres des pistes
• Menu local Speaker Position : permet de choisir l’étiquette de position du haut-parleur

pour la piste sélectionnée. Impulse Response Utility et Space Designer utilisent tous
deux ces étiquettes pour identifier et traiter les fichiers audio composant une réponse
d’impulsion stéréo ou Surround multicanal. Impulse Response Utility définit
automatiquement l’étiquette de position du haut-parleur pour chaque piste, mais vous
pouvez en sélectionner une autre (parmi celles disponibles dans le format de réponse
d’impulsion actuel) si vous le souhaitez.

• Menu local Mic Position : permet de choisir l’étiquette de position du micro pour la piste
sélectionnée. Impulse Response Utility et Space Designer utilisent tous deux ces
étiquettes pour identifier et traiter les fichiers audio composant une réponse d’impulsion
stéréo ou Surround multicanal. Impulse Response Utility définit automatiquement
l’étiquette de position du micro pour chaque piste, mais vous pouvez en sélectionner
une autre (parmi celles disponibles dans le format de réponse d’impulsion actuel) si
vous le souhaitez.

• Menu local Input : permet de définir l’entrée physique de chaque piste. Veillez à
sélectionner la bonne entrée avant l’enregistrement.

• Bouton S[olo] : cliquez dessus pour activer ou désactiver le mode Solo pour la piste
sélectionnée. Lorsque le bouton Solo est activé (jaune), le signal d’entrée est acheminé
vers la section du moniteur et le niveau d’entrée est affiché dans le VU Meter (voir « VU
Meter » ci-dessous). Vous ne pouvez mettre qu’une seule piste à la fois en mode Solo.

• Bouton R[ecord-Enable] : met la piste sélectionnée en mode « Prêt pour
l’enregistrement ». Le bouton E devient rouge lorsqu’il est activé. Le fait de cliquer sur
ce bouton active également le bouton Solo pour la piste sélectionnée, ce qui vous
permet de contrôler le signal d’entrée avant l’enregistrement. Vous pouvez activer
plusieurs pistes à la fois pour un enregistrement multicanal. Lorsque vous cliquez sur
le bouton Sweep/Record, un enregistrement est réalisé sur toutes les pistes activées
pour l’enregistrement.
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• Bouton L[ock] : lorsqu’une piste est verrouillée, les paramètres du générateur de balayage
le sont également. Cela permet de garantir que tous les enregistrements suivants
utilisent les mêmes réglages de balayage. Chaque piste doit en effet utiliser un balayage
sinusoïdal identique pour pouvoir produire une réponse d’impulsion précise avec une
phase cohérente.

• Champ Peak : affiche la valeur du niveau de crête en dB. Si le niveau vient à dépasser
0 dB, la valeur de crête est conservée jusqu’à ce qu’elle soit effacée. Le fait de cliquer
sur l’en-tête de la colonne Peak réinitialise la mesure Peak de toutes les pistes.

• Level : affiche les VU-mètres de chaque piste. Ces VU-mètres affichent toujours le niveau
actuel des entrées physiques.

VU Meter
Mesure soit le niveau de signal présent à l’entrée de la piste (solo) soit la sortie du
générateur de balayage. Pendant la lecture de l’audio enregistré, le VU-mètre affiche le
niveau de la piste sélectionnée. Un message d’état affiché sous le VU-mètre indique son
mode de fonctionnement actuel. L’échelle du VU-mètre va de 0 à 100 %, où 100 %
représente 0 dB.

Exécution d’un enregistrement
Après avoir configuré et activé les pistes souhaitées pour l’enregistrement, cliquez sur le
bouton Sweep/Record. Si vous utilisez le générateur de balayage, le bouton indique
« Sweep ». Si vous n’utilisez pas le générateur de balayage (paramètre Sweep Length
réglé sur Off ), le bouton indique « Record ».

• Cliquez sur Sweep automatically pour démarrer le processus d’enregistrement et générer
le balayage sinusoïdal. Le VU-mètre affiche automatiquement la sortie du générateur
de balayage.

• Le fait de cliquer sur Record lance automatiquement l’enregistrement. Tirez un coup
de pistolet de starter et Impulse Response Utility enregistrera l’audio.
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L’enregistrement se poursuit jusqu’à ce que la durée définie pour le balayage sinusoïdal
(si le générateur de balayage est utilisé) et le paramètre Reverb Length soit écoulée. Il
s’arrête automatiquement. Vous pouvez également interrompre l’enregistrement en
cliquant sur le bouton Sweep/Record.

Remarque : le bouton Sweep/Record est désactivé si aucune piste n’est activée pour
l’enregistrement.

Enregistrement automatique des projets
Impulse Response Utility enregistre l’audio dans la mémoire RAM plutôt que sur le
disque dur. Cela signifie que l’audio enregistré n’est pas sauvegardé tant que vous n’avez
pas enregistré votre projet.

Pour plus de commodité, Impulse Response Utility enregistre automatiquement votre
projet sur disque après chaque enregistrement audio.

Si vous n’avez pas encore enregistré votre projet, la zone de dialogue Save s’ouvre pour
vous permettre de lui attribuer un nom et de choisir un emplacement sur votre disque
dur. Si vous l’avez déjà enregistré auparavant, l’enregistrement se fait automatiquement.
Voir Enregistrement, ouverture et retour aux projets enregistrés pour en savoir plus.

Déconvolution de votre réponse d’impulsion
La déconvolution est le processus utilisé pour créer des réponses d’impulsion à partir de
balayages sinusoïdaux audio à large bande (enregistrés). Si vous utilisez le générateur de
balayage, vous devez déconvoluer vos enregistrements audio pour pouvoir les utiliser
comme réponse d’impulsion.

Pour déconvoluer vos pistes audio
Procédez de l’une des manières suivantes :

µ Cliquez sur le bouton Deconvolve.

µ Choisissez Edit > Deconvolve (ou appuyez sur Maj + Commande + D).

Après la déconvolution, vos pistes audio ne forment plus qu’une seule et même réponse
d’impulsion que vous pouvez écouter, éditer et convertir en fichier de réglage .sdir.
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Remarque : bien qu’il soit possible de déconvoluer chaque piste audio après son
enregistrement, cela ne présente aucun intérêt. Il est beaucoup plus efficace d’attendre
que toutes les pistes soient enregistrées avant de les déconvoluer.

Édition de votre réponse d’impulsion
Une fois vos pistes audio enregistrées, il se peut que vous constatiez trop de silence au
début ou à la fin, qu’elles ne s’atténuent pas suffisamment tôt, etc. Pour corriger ces
problèmes mineurs, Impulse Response Utility vous permet de couper, de tronquer et
d’appliquer un fondu à vos fichiers audio dans la zone Editing.

Pour afficher un fichier audio dans la zone Editing
µ Sélectionnez le fichier audio.

Il apparaît alors automatiquement dans la zone Editing.

Vous pouvez choisir entre trois modes d’affichage différents en cliquant sur les boutons
dans la partie supérieure de la zone Editing :

• Bouton Waveform : affiche l’audio enregistré sous la forme d’une forme d’onde standard.
L’axe horizontal affiche le temps écoulé. L’axe vertical affiche le niveau sonore sous
forme de pourcentage.

• Bouton Energy : affiche la répartition de l’énergie acoustique dans le temps. L’axe
horizontal affiche le temps écoulé. L’axe vertical affiche les niveaux sonores en dB.

• Bouton Spectrogram : affiche la répartition des fréquences dans le temps. L’axe horizontal
affiche le temps écoulé. L’axe vertical affiche les fréquences, colorées en fonction de
la plage de décibels. La légende des couleurs dans le coin supérieur droit de la zone
Editing indique le système de couleurs utilisé.
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Ces modes d’affichage vous permettent d’analyser efficacement vos formes d’onde et
d’identifier facilement les parties à couper ou à tronquer, ou celles nécessitant un fondu.
Le mode Spectrogram, qui affiche simultanément la fréquence, le niveau et le temps, est
particulièrement bien adapté à une analyse très détaillée de votre audio.

Pour sélectionner et lire une partie d’un fichier audio dans la zone Editing
1 Faites glisser le pointeur horizontalement sur la section souhaitée.

2 Écoutez votre sélection en cliquant sur le bouton Play. Cliquez sur le bouton Cycle pour
lire en continu la piste sélectionnée.

Astuce : utilisez la barre d’espace pour mettre en pause ou reprendre la lecture ou la
touche C pour mettre en pause ou reprendre la lecture en boucle.

Pour modifier la partie sélectionnée d’un fichier audio
µ Choisissez l’une des opérations d’édition parmi les boutons du coin supérieur gauche de

la zone Editing :

• Bouton Crop : si vous effectuez une sélection n’incluant ni le début ni la fin de l’audio,
le bouton d’édition de gauche active la fonction Crop. Le fait de cliquer sur ce bouton
supprime l’audio se trouvant à droite et à gauche de votre sélection, sans affecter l’audio
sélectionné. Vous pouvez également choisir Edit > Crop (ou appuyer sur Commande + X)
à cette fin.

• Bouton Cut : si vous effectuez une sélection incluant le début ou la fin de l’audio, le
bouton d’édition de gauche active la fonction Cut. Le fait de cliquer sur ce bouton
supprime la sélection sans affecter l’audio non sélectionné. Vous pouvez également
choisir Edit > Cut (ou appuyer sur Commande + X) à cette fin.

• Bouton Fade : si vous effectuez une sélection incluant le début ou la fin de l’audio, vous
pouvez sélectionner la fonction Fade. Le fait de cliquer sur ce bouton crée un fondu
progressif sur toute la longueur de la zone sélectionnée. Vous pouvez également choisir
Edit > Fade (ou appuyer sur Commande + F).

Remarque : pour préserver la cohérence de phase entre toutes les pistes de votre réponse
d’impulsion, les opérations d’édition sont appliquées de la même manière à toutes les
pistes. Pour que votre réponse d’impulsion ne comporte aucune piste éditée de manière
différente, vous ne pouvez plus enregistrer d’autres pistes après une session d’édition.

Écoute de votre réponse d’impulsion
Pour vous faire une idée du son de votre réponse d’impulsion lorsqu’elle sera utilisée
dans Space Designer, vous devez pouvoir l’écouter en contexte. Impulse Response Utility
inclut à cette fin une fenêtre Audition dans laquelle vous pouvez convoluer la réponse
d’impulsion chargée avec des fichiers audio test. La fenêtre Audition est divisée en trois
sections : la zone Impulse Response, la zone Monitor et la zone Audio Test Files.
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L’apparence de la fenêtre Audition change légèrement lorsque vous utilisez une réponse
d’impulsion en format B. La fenêtre Audition du format B supprime le paramètre Output
Channel de la zone Track et comprend une zone Loudspeaker :

Fenêtre des réponses 
d’impulsion B-Format

Fenêtre des réponses 
d’impulsion d’audition

Impulse Response Utility permet de charger/d’utiliser jusqu’à cinq fichiers audio comme
sources lors de l’écoute de votre réponse d’impulsion. La fenêtre Audition comprend
également quatre fichiers sources de test.

Pour ouvrir la fenêtre Audition
µ Cliquez sur le bouton Audition IR.

La fenêtre Audition s’ouvre. Toutes les fonctions d’édition sont désactivées lorsque cette
fenêtre est ouverte.

Audition des paramètres d’Impulse Response Utility
• Case Enable : permet d’activer ou de désactiver les différents enregistrements de réponse

d’impulsion. Utilisez ces cases pour sélectionner le ou les fichiers à écouter.

• Étiquette Input ID : identifie le fichier de réponse d’impulsion à l’aide de ses positions
de haut-parleur > micro.

• Menu local Output Channel (non disponible pour les réponses d’impulsion en format
B) : permet de sélectionner le canal de sortie physique utilisé pour la lecture de la
réponse d’impulsion sélectionnée.
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• Champ Mix : détermine le rapport signal source test sec/signal d’effet.

• Champ Monitor Level : permet de définir le niveau d’écoute global.

• Boutons Test Audio File : permet de lire l’un des quatre fichiers audio sources de test
inclus.

• Boutons Open : cliquez dessus pour charger un fichier audio à utiliser comme source
de test. Vous pouvez utiliser n’importe quel fichier audio non compressé.

• Boutons Play : cliquez dessus pour lire le fichier audio sélectionné combiné avec le ou
les fichiers de réponse d’impulsion activés.

Paramètres de la zone Loudspeaker (spécifiques au format B)
• Champ Number of Loudspeakers : permet de définir le nombre de haut-parleurs utilisés

par Impulse Response Utility pour décoder la réponse d’impulsion. Cliquez sur les
flèches pour augmenter ou diminuer le nombre de haut-parleurs, ou double-cliquez
sur le nombre affiché et saisissez une nouvelle valeur.

• Champ Loudspeaker Angle : permet de configurer l’angle de chaque haut-parleur. Le
décodage du format B prend ce paramètre en compte pour recréer l’espace enregistré.

• Menu local Output Channel : permet de définir le canal de sortie physique du haut-parleur
sélectionné.

Création d’un réglage Space Designer
Lorsque vous êtes satisfait de votre réponse d’impulsion, vous pouvez générer un fichier
.sdir, ainsi qu’un réglage de module. Une fois cette opération réalisée, vous pourrez utiliser
votre nouvelle réponse d’impulsion dans Space Designer.

Pour créer un réglage Space Designer
Procédez de l’une des manières suivantes :

µ Cliquez sur le bouton « Create Space Designer Setting ».

µ Choisissez File > « Create Space Designer Setting ».

Impulse Response Utility génère un fichier .sdir de votre réponse d’impulsion et l’enregistre
dans le répertoire suivant : ~/Bibliothèque/Application Support/Logic/Impulse Responses.

Un fichier de réglage de module pour votre réponse d’impulsion est également généré
et enregistré dans le répertoire suivant : ~/Bibliothèque/Application Support/Logic/Plug-In
Settings/Space Designer.
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Votre nouvelle réponse d’impulsion sera disponible dans Space Designer à la prochaine
ouverture de Logic Pro.

Enregistrement, ouverture et retour aux projets enregistrés
Le fichier d’Impulse Response Utility est un paquet Mac OS X contenant tous les fichiers
associés au projet.

Enregistrement de projets
Impulse Response Utility enregistre automatiquement votre projet dès que vous effectuez
un enregistrement audio (voir Enregistrement automatique des projets). Vous pouvez
toutefois l’enregistrer manuellement à tout moment. Vous pouvez également ouvrir un
projet précédemment enregistré ou revenir à la dernière version enregistrée du projet
ouvert.

Pour enregistrer votre projet en utilisant son nom et son emplacement actuels
µ Choisissez File > Save Project (ou appuyez sur Commande + S) pour enregistrer votre

projet de réponse d’impulsion sous son nom actuel dans son emplacement actuel.

Pour enregistrer votre projet en utilisant un nouveau nom ou un nouvel emplacement
µ Choisissez File > Save As (ou appuyez sur Commande + Maj + S).

Ouverture des projets
Si vous souhaitez poursuivre votre travail sur un projet précédemment enregistré, vous
devez d’abord l’ouvrir.

Pour ouvrir un projet
µ Choisissez File > Open Project (ou appuyez sur Commande + O), puis recherchez votre

fichier de projet.

µ Choisissez File > Open Recent pour ouvrir un menu hiérarchique des fichiers de projet
récemment ouverts.

Revenir aux projets enregistrés
Si vous n’êtes pas satisfait des modifications ou des enregistrements effectués dans le
projet en cours et que vous avez déjà enregistré ce dernier, vous pouvez utiliser la
commande File > Revert to Saved. Cela permet de revenir à la dernière version enregistrée
du projet.

Remarque : lorsque vous utilisez la commande « Revert to Saved », vous perdez toutes
les modifications non enregistrées.
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Vous n’êtes pas limité à la création de réponses d’impulsion de pièces et d’espaces. Vous
pouvez créer une réponse d’impulsion de tout appareil permettant de lire un balayage
sinusoïdal à large bande (et d’enregistrer le résultat). Voici deux exemples : les enceintes
acoustiques de guitare et les périphériques de traitement matériels tels que les égaliseurs
à lampes et les unités de réverbération.

Le présent chapitre couvre les aspects suivants :

• Enregistrement de réponses d’impulsion à partir d’enceintes de guitare (p 35)

• Enregistrement de réponses d’impulsion à partir de périphériques matériels (p 36)

Enregistrement de réponses d’impulsion à partir d’enceintes
de guitare
Le son d’une guitare électrique émis par un amplificateur de guitare est très influencé
par la réponse en fréquence et la couleur de l’enceinte acoustique. Si vous créez une
réponse d’impulsion d’une enceinte acoustique de guitare et que vous combinez ensuite
un signal d’amplificateur de guitare direct avec cette réponse d’impulsion dans Space
Designer (avec l’effet réglé à 100 %), le signal direct sonnera comme s’il était émis par
l’enceinte.

Vous devez toujours disposer d’un micro et d’une interface audio pour créer une réponse
d’impulsion d’une enceinte acoustique de guitare, mais vous n’avez pas besoin d’un
haut-parleur de monitoring supplémentaire pour le balayage sinusoïdal à large bande
dans la mesure où celui-ci est lu via le haut-parleur/l’amplificateur de guitare lui-même.
Si votre amplificateur de guitare est doté d’un retour d’effets, vous pouvez l’utiliser pour
créer la réponse d’impulsion. S’il en est dépourvu, vous pouvez utiliser un boîtier de
« ré-amplification » (qui augmente l’impédance de la sortie de ligne de votre interface
audio au niveau requis par l’entrée de votre amplificateur de guitare) ou un amplificateur
de niveau de ligne en lieu et place de votre amplificateur de guitare (pour amplifier le
balayage sinusoïdal via l’enceinte acoustique de guitare).
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Vous pouvez tester plusieurs positionnements de micro tout comme vous le feriez pour
la prise de son d’un espace physique, mais sachez que le positionnement le plus courant
est la « prise de son de proximité », qui consiste à placer votre micro très près du
haut-parleur (jusqu’à 2,5 cm). L’illustration ci-dessous montre comment vous pouvez
installer votre enceinte acoustique de guitare pour créer votre réponse d’impulsion.

Ampli de guitare
avec micro

OrdinateurInterface audio

Enregistrement de réponses d’impulsion à partir de
périphériques matériels
Imaginons que vous souhaitiez créer une réponse d’impulsion de votre préamplificateur
de micro à lampe favori pour pouvoir appliquer sa couleur unique à votre audio. Vous
pourriez ainsi combiner un signal avec cette réponse d’impulsion dans Space Designer
(avec l’effet réglé à 100 %) en vue d’ajouter la couleur de votre préamplificateur de micro
à ce signal.

Ce scénario ne nécessite ni haut-parleurs ni micros. Il suffit de brancher la sortie de votre
interface audio sur l’entrée de votre périphérique matériel et de lire le balayage sinusoïdal
via ce dernier. Branchez ensuite la sortie de votre périphérique matériel sur l’entrée de
votre interface audio pour enregistrer le signal dans Impulse Response Utility. Vous pouvez
utiliser cette méthode pour créer des réponses d’impulsion d’unités de réverbération,
d’unités multi-effets ou encore d’égaliseurs matériels.

Vous devez être prudent lors de la création de réponses d’impulsion de périphériques
d’effets matériels incluant des effets de modulation. Les modulations telles que les
rotophaseurs, les chorus, etc. interfèrent avec le balayage sinusoïdal lui-même, ce qui
rend la déconvolution difficile, voire impossible. Cela vaut également pour certaines
unités de réverbération telles que les périphériques de réverbération matériels Lexicon
classiques, dans lesquels les queues de réverbération sont modulées. Dans ces cas, il est
préférable d’envoyer une impulsion enregistrée (telle qu’un pic ou un coup de feu) au
périphérique d’effets matériel plutôt qu’un balayage sinusoïdal.
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Le format B est une technique spéciale d’encodage d’informations spatiales. Il représente
l’espace à l’aide de quatre flux audio : un pour capturer la pression acoustique (W) et trois
pour capturer les coordonnées X (avant vers arrière), Y (gauche à droite) et Z (haut vers
bas) de la pièce. L’illustration ci-dessous montre comment ces quatre flux audio
interagissent entre eux pour créer une image spatiale en trois dimensions.

Hauteur
Z

Avant
X

Droite
Y

Z

Y
Gauche

X
Arrière

W

Space Designer peut décoder et convoluer ces quatre flux audio en réverbérations dans
tous les formats Surround pris en charge. Space Designer offre une bibliothèque complète
de réponses d’impulsion au format B utilisant les quatre flux (W, X, Y et Z). Dans la mesure
où les réponses d’impulsion n’utilisent pas les informations de l’axe Z, Impulse Response
Utility n’enregistre et n’encode que les informations des signaux W, X et Y, ce qui permet
d’économiser de l’espace disque et les ressources de l’unité centrale. Impulse Response
Utility permet d’encoder tous les formats de réponse d’impulsion Surround pris en charge
au format B.

Le présent chapitre couvre les aspects suivants :

• Avantages de l’encodage Surround au format B (p 38)

• Micros recommandés pour l’enregistrement au format B (p 38)
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Avantages de l’encodage Surround au format B
L’un des avantages du format B est qu’il permet de capturer une image Surround avec
moins de fichiers audio. En temps normal, vous devez enregistrer chaque position de
haut-parleur depuis chaque position de micro pour enregistrer correctement toutes les
informations Surround. Avec le format B, ces quatre flux audio (ou trois, dans Impulse
Response Utility) sont tout ce dont vous avez besoin pour capturer l’audio de chaque
haut-parleur.

Imaginons par exemple que vous utilisiez une installation à cinq canaux et que vous
souhaitiez créer une réponse d’impulsion à cinq canaux à l’aide d’Impulse Response Utility.
Avec les méthodes classiques, vous devriez enregistrer les cinq haut-parleurs depuis les
cinq positions de micro, ce qui générerait 25 fichiers audio. Si vous choisissez de créer
un projet de réponse d’impulsion à cinq canaux au format B, vous n’aurez à enregistrer
que 15 fichiers audio, soit trois enregistrements audio (W, X et Y) pour chacune des cinq
positions de haut-parleur. Comme vous pouvez le constater, les réponses d’impulsion
Surround encodées au format B nécessitent beaucoup moins de fichiers audio, ce qui
signifie moins d’espace disque, et également moins de mémoire RAM et de cycles d’unité
centrale lors du décodage dans Space Designer.

Un autre avantage de l’encodage au format B est la cohérence de phase lors de l’utilisation
simultanée de plusieurs micros. Lorsque vous utilisez plusieurs micros, les différences de
temps nécessaire au son pour atteindre chacun d’eux peuvent produire des annulations
de phase et des déphasages, ce qui peut affecter la qualité de votre réponse d’impulsion.
Dans la mesure où le point de référence est toujours le même avec l’encodage au format B,
il n’y a pas de problèmes de phase, même lorsque vous utilisez plusieurs micros pour
enregistrer votre réponse d’impulsion.

Micros recommandés pour l’enregistrement au format B
Les meilleurs micros pour l’enregistrement au format B sont probablement les micros
Surround de marque SoundField. Ces micros contiennent toutes les capsules dont vous
avez besoin pour réaliser un enregistrement de référence complet au format B en une
seule prise et incluent les composants matériels nécessaires à l’envoi des flux d’axe distincts
aux différentes pistes d’Impulse Response Utility. Il suffit de faire pivoter le micro une fois
en direction de chaque position de haut-parleur et le matériel du micro et de traitement
s’occupe du reste. Pour les personnes ne pouvant pas investir dans des micros SoundField,
Impulse Response Utility offre d’autres options de micro pour l’enregistrement au format B.
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La capture du signal W (pression acoustique) nécessite un micro omnidirectionnel. La
capture des signaux d’axe X et Y nécessite un micro bidirectionnel (pour capturer le signal
à l’avant et à l’arrière du micro). Ainsi, vous pouvez enregistrer chaque position de
haut-parleur en une seule prise à l’aide de deux micros bidirectionnels, l’un étant dirigé
directement vers la source du haut-parleur (X) et l’autre placé perpendiculairement (Y),
et d’un micro omnidirectionnel pour la pression acoustique (W). Veillez à positionner les
micros de façon à ce que leurs capsules soient aussi proches que possible l’une de l’autre,
l’idéal étant d’avoir un point de référence unique compact pour chaque position de
haut-parleur.

Vous devrez faire pivoter chaque micro bidirectionnel vers chaque position de haut-parleur.
Il n’est pas nécessaire de déplacer le micro omnidirectionnel car sa capsule capte le son
à 360 degrés.

Même si votre budget est trop limité pour acquérir trois micros différents, vous pouvez
toujours créer des réponses d’impulsion au format B en enregistrant chaque flux audio
séparément dans Impulse Response Utility. Il vous suffit pour cela de disposer d’un micro
permettant de basculer entre une courbe omnidirectionnelle et une courbe
bidirectionnelle. De nombreux micros performants (à tous les prix) offrent cette possibilité.
Vous devrez souvent basculer d’une courbe de directivité à une autre et faire pivoter les
micros, mais cela est faisable.
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Cette index vous guide tout au long du processus de création d’une réponse d’impulsion,
de la création du projet à la génération du réglage Space Designer final. Pour ce guide
d’initiation, imaginons que vous ayez l’autorisation d’enregistrer dans une salle de concert
locale ayant une acoustique particulièrement bonne. Dans la mesure où cette opportunité
ne se présentera probablement plus jamais, vous avez décidé d’enregistrer une réponse
d’impulsion Surround à cinq canaux distincts.

Cet appendice traite des sujets suivants :

• Création d’une réponse d’impulsion Surround à cinq canaux (p 41)

• Enregistrement d’une réponse d’impulsion à 5 canaux Mono vers Omni (p 43)

Création d’une réponse d’impulsion Surround à cinq canaux
Les étapes décrites ci-dessous doivent être suivies lorsque vous voulez créer une réponse
d’impulsion Surround à cinq canaux discrète.

Étape 1 : Installation des micros et des haut-parleurs
La première étape consiste à installer vos haut-parleurs et vos micros. Imaginons que
vous ayez décidé d’utiliser l’approche de l’auditeur virtuel, qui nécessite cinq haut-parleurs
et au moins un micro placé au centre que vous pouvez orienter tour à tour vers chacun
des haut-parleurs. Vous devriez idéalement disposer de cinq moniteurs amplifiés
identiques. Cela vous fera gagner du temps lors de l’enregistrement et vous permettra
de voir tous les haut-parleurs à la fois, de vous assurer qu’ils sont tous à la même distance
des coins et des murs, etc. Une fois tous les haut-parleurs positionnés, vous devez installer
votre micro au centre de la salle. Vérifiez que tous les composants sont correctement
connectés à votre interface audio.

Étape 2 : Création d’un projet
L’étape suivante consiste à ouvrir Impulse Response Utility et à créer un projet de réponse
d’impulsion à cinq canaux. La zone de dialogue « New Impulse Response Project » vous
informe que ce format nécessite cinq positions de haut-parleur et de micro. Lorsque vous
fermez la zone de dialogue, vingt-cinq pistes audio s’affichent dans la section Inputs/Track,
une pour chaque position de haut-parleur depuis chaque position de micro.
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Étape 3 : Configuration des paramètres d’Impulse Response Utility
Orientez votre micro vers le haut-parleur à enregistrer (celui situé devant à gauche, par
exemple). Configurez la section Monitor, le générateur de balayage et l’entrée pour la
piste sélectionnée.

Étape 4 : Enregistrement
Activez la piste sélectionnée pour l’enregistrement, puis cliquez sur le bouton Sweep.
Impulse Response Utility vous invite à saisir un nom pour le nouveau projet et à
l’enregistrer une fois le premier enregistrement terminé.

Faites pivoter le micro vers la deuxième position Surround, activez la piste pour
l’enregistrement, puis cliquez sur le bouton Sweep. Une fois l’enregistrement terminé, le
projet est automatiquement enregistré en arrière-plan. Si vous le souhaitez, vous pouvez
lire la piste dans la zone Editing pour contrôler l’enregistrement.

Répétez cette procédure vingt-trois fois de plus jusqu’à ce que vous ayez enregistré les
vingt-cinq pistes audio nécessaires à la capture de toutes les combinaisons de positions
de micro et de haut-parleur possibles.

Étape 5 : Déconvolution
Cliquez sur le bouton Deconvolve après avoir enregistré (et contrôlé) les fichiers audio
pour chaque position. À ce stade, vous devriez enregistrer le projet.

Étape 6 : Édition et écoute
Si vous constatez la présence de silence superflu au début ou à la fin de votre réponse
d’impulsion, utilisez la zone Editing pour le supprimer. Utilisez la fenêtre Audition pour
écouter des données de test combinées avec votre réponse d’impulsion pour vous assurer
que le résultat est bien celui escompté. Si le résultat n’est pas satisfaisant, continuez
d’éditer votre réponse d’impulsion. Si vous n’êtes toujours pas satisfait du résultat,
recommencez à partir de l’étape deux ou trois.

Étape 7 : Création d’un réglage Space Designer
Lorsque vous êtes entièrement satisfait de votre réponse d’impulsion, vous pouvez cliquer
sur « Create Space Designer Setting ». Impulse Response Utility génère alors les fichiers
.sdir et de réglages Space Designer. Votre nouvelle réponse d’impulsion sera disponible
à la prochaine ouverture de Space Designer.
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Enregistrement d’une réponse d’impulsion à 5 canaux Mono
vers Omni
La procédure décrite dans la rubrique Création d’une réponse d’impulsion Surround à
cinq canaux est un exemple d’enregistrement d’une véritable réponse d’impulsion
Surround. Bien souvent, vous pouvez vous contenter d’enregistrer une seule position de
haut-parleur pour créer une réponse d’impulsion mono/omni discrète. Les réponses
d’impulsion mono/omni discrètes sont non seulement plus faciles et plus rapides à
enregistrer, mais elles nécessitent également moins de puissance de l’unité centrale.

Pour créer une réponse d’impulsion à 5 canaux Mono vers Omni
1 Choisissez le modèle de canaux « Mono/Omni to 5 » dans la zone de dialogue New Projects.

Vous verrez que les projets de réponse d’impulsion mono/omni discrète ne nécessitent
qu’un seul haut-parleur.

2 Orientez votre haut-parleur vers le plafond ou vers un mur situé derrière.

3 Orientez votre micro vers la première position Surround : devant à gauche, par exemple.

4 Enregistrez le balayage.

5 Répétez cette procédure pour toutes les autres positions de micro.
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